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Mục tiêu bài học

• Tạo tài liệu và bản trình chiếu cơ bản

• Hiểu về các tham chiếu trong tài liệu

• Biết lưu và sao lưu công việc

• Hiểu khái niệm cơ bản về in ấn



Sử dụng Microsoft Word

• Các tính năng phổ biến
• Tìm hiểu về chế độ xem Hậu trường

(Backstage View)
• Chọn và tạo một tài liệu mới trống

(Blank Document) hoặc mẫu (template)

được liệt kê trong thư viện.

• Truy cập các thành phần khác bằng cách

nhấp vào liên kết Open Other

Documents, Info, New, Open, Save, Save

As, History, Print, Share, Export, Close

và Account.



Sử dụng Microsoft Word

• Màn hình soạn thảo



Sử dụng Microsoft Word

• Truy cập các lệnh và tính năng
• Mẹo màn hình (ScreenTips)
• Đặt con trỏ chuột lên một lệnh/thành

phần, ScreenTip xuất hiện mô tả ngắn gọn

về lệnh/thành phần và phím tắt nếu có.

• Sử dụng Thanh công cụ Truy cập nhanh

QAT (Quick Access Toolbar)
• Theo mặc định, QAT chỉ hiện các nút

Save, Undo và Redo (và nút Chế độ Cảm

ứng nếu có màn hình cảm ứng).

• Có thể tùy chỉnh QAT để bổ sung các lệnh

thường xuyên sử dụng.



Sử dụng Microsoft Word

• Sử dụng Ribbon
• Ribbon chứa các biểu tượng (Icon) lệnh của các Thẻ

(Tab) lệnh.

• Các biểu tượng lệnh được gom nhóm (Group) trên mỗi

thẻ.

• Biểu tượng lệnh đang được kích hoạt có màu nền khác

so với các biểu tượng lệnh khác.

• Biểu tượng lệnh có mũi tên sẽ cung cấp hai lựa chọn
• Nhấp vào biểu tượng lệnh sẽ nhận giá trị hiện tại.

• Nhấp vào mũi tên để hiển thị trình đơn thả xuống với nhiều

tùy chọn cho lệnh đó.



Sử dụng Microsoft Word
• Nếu một nhóm bao gồm tính năng có thanh cuộn/nút cuộn, nhấp vào

nút (More) dưới cùng để hiển thị danh sách đầy đủ các lựa chọn cho

tính năng đó. Nhóm tính năng này gọi là thư viện (Gallery).

• Khi đặt con trỏ chuột tại một tùy chọn nào đó trong thư viện, ứng dụng

sẽ cho xem trước trực tiếp về mục đang chọn.



Sử dụng Microsoft Word

• Một số nhóm trên Ribbon có

nút trình khởi chạy Hộp thoại

(Dialog box launcher) ở góc

phải dưới của nhóm.

• Nhấp vào nút khởi chạy hộp

thoại để mở hộp thoại tác vụ

chứa tính năng/công cụ cần

thao tác



Sử dụng Microsoft Word

• Nhập và chỉnh sửa văn bản
• Có thể nhập/chèn văn bản vào bất kỳ vị trí nào trong văn bản

Con trỏ sẽ di chuyển sang phải khi nhập

• Để di chuyển con trỏ đến vị trí khác trong tài liệu → nhấp

chuột vào vị trí đó.

• Để xóa văn bản, sử dụng phím BACKSPACE để xóa các ký tự

ở bên trái con trỏ, nhấn Delete để xóa các ký tự bên phải con trỏ.

• Chỉ nhấn Enter khi muốn kết thúc một đoạn hoặc để thêm một

dòng trống



Sử dụng Microsoft Word

• Chọn văn bản
• Để chọn một từ: Nhấp đúp vào vào từ đó.

• Để chọn một câu: Giữ CTRL và nhấp vào bất cứ nơi nào trong câu.

• Để chọn một đoạn: Nhấp vào ba lần vào bất cứ nơi nào trong

đoạn/nhấp đúp chuột vào vùng lựa chọn bên trái đoạn cần chọn.

• Để chọn toàn bộ tài liệu: Trên thẻ Home, nhóm Editing →

Chọn Select → Chọn Select All hoặc nhấn CTRL+A hoặc

nhấp ba lần chuột vào vùng lựa chọn bên trái văn bản.



Sử dụng Microsoft Word

• Chọn văn bản liên tục
• Định vị con trỏ, nhấn và giữ phím Shift → Nhấn các phím mũi tên

để di chuyển con trỏ hoặc nhấp chuột vào điểm cuối phạm vi của

văn bản cần chọn → Nhả phím Shift.

• Chọn văn bản không liên tục
• Chọn đoạn văn bản đầu tiên → Nhấn và giữ Ctrl khi chọn đoạn

văn bản tiếp theo.



Sử dụng Microsoft Word

• Lưu tài liệu
• Nhấp vào thẻ File → Chọn Save/Save As → Điều hướng đến

nơi cần lưu → Đặt tên tập tin → Chọn Save .

• Nhấp vào nút Save trên QAT; hoặc nhấn Ctrl+S.

• Để lưu tài liệu hiện có với một tên khác → chọn SaveAs trong thẻ File



Sử dụng Microsoft Word

• Up One Level: Lên một cấp

• Current Folder: Thư mục hiện hành

• File name: Tên tập tin

• Save as Type: Lưu thành loại tập tin

• Drives or locations save: Ổ đĩa hoặc

vị trí lưu trữ

• Folders or documents in current

folder: Thư mục hoặc tập tin trong

thư mục hiện hành

• Data created or modified: Ngày tạo

hoặc chỉnh sửa



Sử dụng Microsoft Word

• Các loại tập tin

.doc
Loại tập tin được liên kết với các phiên bản Microsoft Word trước năm

2007. Nhiều chương trình xử lý văn bản có thể mở tập tin có phần mở rộng .doc.

.txt Loại tập tin thuần văn bản có thể được đọc trên bất kỳ HĐH nào.

.rtf 
Loại tập tin văn bản vẫn giữ các định dạng trong tài liệu (Font, Paragraph, 

Picture,…).

.pdf
Loại tập tin được phát triển bởi Adobe Systems cho phép xem tài liệu trên 

bất kỳ HĐH nào.

.pub
Loại tập tin mặc định được sử dụng trong Microsoft Publisher bao gồm 

thông tin bố cục, định dạng, đồ họa, siêu liên kết, biểu đồ và các loại đối 

tượng khác



Sử dụng Microsoft Word

• Các loại tập tin



Sử dụng Microsoft Word

• Bắt đầu một tài liệu mới
• Trong Backstage view → Chọn New

→ Chọn Blank document hoặc,

• Nhấn Ctrl+N.

• Để chọn từ tài liệu → Nhấp chọn

mẫu được hiển thị → Chọn Create.



Sử dụng Microsoft Word

• Áp dụng định dạng

• Định dạng là quá trình thay đổi hiển thị hoặc vị trí văn 

bản/các đối tượng trong tài liệu.

• Có thể áp dụng định dạng cho văn bản trong khi nhập hoặc sau 

khi đã nhập.

• Khi muốn xóa tất cả định dạng khỏi văn bản đã chọn, trên thẻ 

Home, nhóm Font → nhấp chọn  Clear Formatting.



Sử dụng Microsoft Word

• Định dạng ký tự (Characters)

• Font: Thay đổi kiểu chữ của các ký tự trên màn hình và trong bản in.

• Font Size: Thay đổi kích cỡ của các ký tự.

• Character Formatting: Là các biến thể cách điệu đặc biệt được áp 

dụng cho các ký tự thô gồm Bold, Italic, Underlines.

• Effects: Áp dụng các hiệu ứng đặc biệt cho văn bản gồm 

Strikethrough, Superscript, Subscript, Shadow, SMALL CAPS,…

• Có thể định dạng văn bản bằng các phím tắt như Ctrl+B in đậm, 

Ctrl+I in nghiêng hoặc Ctrl+U cho gạch chân.



Sử dụng Microsoft Word

• Định dạng đoạn văn bản (Paragraph)

• Căn chỉnh văn bản

• Là định dạng canh trái/phải của một đoạn văn theo chiều 

ngang trên trang. Chọn một trong bốn tùy chọn trong 

nhóm Paragraph trên thẻ Home:

• Alight Left: Căn chỉnh văn bản đều ở bên trái.

• Center: Căn chỉnh văn bản giữa lề trái và lề phải ở giữa trang.

• Alight Right: Căn chỉnh văn bản đều bên phải và sang lề phải

• Justify: Căn chỉnh văn bản sao cho cạnh trái và phải ngang 

bằng với lề ngoại trừ dòng cuối cùng của mỗi đoạn.



Sử dụng Microsoft Word

• Thay đổi khoảng cách dòng (Line Spacing)

• Là khoảng cách giữa các dòng văn bản được nhập, được 

đo từ đường cơ sở của một dòng đến đường cơ sở của 

dòng tiếp theo. 

• Word tự động điều chỉnh khoảng cách giữa các dòng 

theo kích thước của các ký tự được sử dụng.

• Người dùng có thể thiết lập khoảng cách dòng bằng một 

số cụ thể.

• Để đặt/thay đổi khoảng cách dòng, trên thẻ Home, nhóm 

Paragraph, nhấp chọn Line and Paragraph Spacing.



Sử dụng Microsoft Word

• Thiết lập khoảng cách đoạn văn bản (Paragraph Spacing)

• Paragrap spacing là khoảng cách giữa các đoạn văn bản. 

• Để thiết lập/thay đổi khoảng cách đoạn, nhấp vào thẻ Layout, 

nhóm Paragraph, đặt khoảng cách theo yêu cầu. 



Sử dụng Microsoft Word

• Sử dụng Style. 

• Sử dụng định dạng nhanh (Quick Styles)

• Style là sự kết hợp của Font, Color, Size và có thể được áp dụng 

cho bất kỳ văn bản nào trong tài liệu.

• Style là sự kết hợp giữa định dạng ký tự và đoạn văn bản.

• Mỗi Style được lưu với một tên duy nhất.



Sử dụng Microsoft Word

• Các chức năng trong cửa sổ Quick Styles bao gồm:

• Create a Style: Tạo một Style mới.

• Clear Formatting: Xóa các định dạng văn bản đã được áp dụng 

Style và trả về Normal Style.

• Apply Style (Ctrl+Shift+S): Hiển thị một cửa sổ cho phép chọn 

Style từ danh sách hoặc nhập tên Style sẽ áp dụng.



Sử dụng Microsoft Word

• Sử dụng cửa sổ Style (Style Pane)

• Style Pane cho biết Style nào áp dụng cho ký tự, cho đoạn 

VB hoặc cả hai.

• Khi trỏ chuột vào một Style bất kỳ trong Style Pane, Word sẽ 

cho biết các thông tin cụ thể về Style đó.

• Style Pane cho biết cụ thể về phạm vi áp dụng của Style và

hiện đang có bao nhiêu trường hợp (Instance) đang được áp 

dụng Style cụ thể.

• Styles: Hiển thị danh sách các Style có sẵn cho mọi tài liệu mới.

• Show Preview: Hiển thị mỗi tên Style được định dạng theo các 

thuộc tính của Style.

• Disable Linked Styles: Các kiểu được liên kết chỉ có thể hoạt 

động giống như kiểu đoạn văn bản.



Sử dụng Microsoft Word

•       New Style: Cho phép tạo một Style mới

• Style Inspector: Hiển thị hộp thoại để xem lại các thuộc tính Style 

giúp tùy chỉnh hoặc quản lý Style.

• Manage Styles: Thiết lập các tùy chọn mặc định cho Style hiển thị 

trong Style Pane bằng cách sử dụng các thuộc tính mặc định cho 

Style cụ thể. Cũng có thể chỉnh sửa các Style trong hộp thoại này.

• Options: Kiểm soát hành vi và sự xuất hiện của Style Pane



Sử dụng Microsoft Word

• Áp dụng các chủ đề (Themes)

• Là tập hợp các yếu tố thiết kết hợp như 

màu sắc, font chữ và đồ họa 

• Cung cấp giao diện nhất quán cho tất cả các 

trang trong tài liệu. 

• Người dùng có thể hiệu chỉnh màu (Theme 

Colors) và font chữ (Theme Fonts) tùy theo 

nhu cầu cụ thể.



Sử dụng Microsoft Word

• Sử dụng Document Style Sets

• Là một tập hợp hoặc nhóm các kiểu (Style) có thể được áp dụng 

để tạo cho tài liệu một diện mạo chuyên nghiệp và nhất quán. 



Sử dụng Microsoft Word

• Định dạng tài liệu

• Thay đổi Khổ giấy (Paper Size)

• Khổ giấy mặc định được xác định bởi thiết lập 

ngôn ngữ và khu vực hệ thống của người dùng

• Nếu máy tính cài đặt ngôn ngữ tiếng Anh và khu 

vực là Mỹ thì khổ giấy mặc định là Letter. 

• Tại Việt Nam, khổ giấy thông dụng là A4. 

• Người dùng có thể thay đổi khổ giấy phù hợp bằng 

cách sử dụng thẻ Layout, nhóm Page Setup → 

Chọn Size → chọn kích thước phù hợp từ danh sách.



Sử dụng Microsoft Word

• Thay đổi hướng trang (Orientation)

• Hướng trang đề cập đến cách tài liệu sẽ in trên trang. 

• Portrait hiển thị văn bản theo hướng dọc của tờ giấy, 

• Landscape hiển thị theo hướng ngang của tờ giấy.

• Để thay đổi hướng trang cho tài liệu, trên thẻ Layout, nhóm Page 

Setup → nhấp chọn Orientation → chọn hướng trang. 



Sử dụng Microsoft Word

• Thay đổi lề trang (Margins)

• Lề trang xác định không gian giữa cạnh giấy in và khu vực văn bản.

• Trên thước đo ngang/dọc, đường phân chia giữa màu sáng (lề trong) 

và màu tối (lề ngoài). 

• Để thay đổi lề trang, trên thẻ Layout, nhóm Page Setup → nhấp 

chọn Margins → Chọn kiểu lề trang.



Sử dụng Microsoft Word

• Sử dụng dấu đầu dòng và đánh số (Bullets and 

Numbering)

• Sử dụng dấu đầu dòng (Bullets)

• Chọn các đoạn văn bản cần đánh dấu đầu dòng →

• Trên thẻ Home, nhóm Paragraph → nhấp chọn 

biểu tượng hoặc;

• Nhấp chọn  để mở danh sách dấu đầu dòng →

chọn kiểu dấu đầu dòng hoặc;

• Nhấp chọn biểu tượng  trong Mini Toolbar hoặc;

• Nhấp chọn   để mở danh sách dấu đầu dòng →

chọn kiểu dấu đầu dòng.



Sử dụng Microsoft Word

• Sử dụng đánh số đầu dòng (Numbering)

• Chọn các đoạn văn bản cần đánh số đầu dòng →

• Trên thẻ Home, nhóm Paragraph → nhấp chọn 

biểu tượng   hoặc;

• Nhấp chọn   để mở danh sách kiểu số đầu dòng →

chọn kiểu số đầu dòng hoặc;

• Nhấp chọn biểu tượng   trong Mini Toolbar hoặc;

• Nhấp chọn   để mở danh sách kiểu số đầu dòng 

→ chọn kiểu đánh số đầu dòng. 



PowerPoint là gì?

• Là một ứng dụng trình chiếu dùng để tạo, chỉnh sửa và thao 

tác với các trang trình chiếu (slide) trên màn hình trình chiếu. 

• Các bài trình chiếu có thể được phân phối cho người xem 

trực tuyến, hoặc có thể tự xem trên thiết bị của người dùng.



PowerPoint là gì?

• Một bài thuyết trình bao gồm những gì?

Trang tiêu đề (Title Slide) 
Slide mở đầu giới thiệu chủ đề của bài 

thuyết trình

Trang chương trình 

(Agenda Slide)

Liệt kê tiêu đề của tất cả các trang trình bày 

trong bản trình bày 

Trang tiêu đề và nội dung 

(Title and Content Slide 

Trang chiếu tiêu đề và nội dung thường là 

trang chiếu danh sách có dấu đầu dòng 

Trang hỗ trợ nội dung 

(Support Content Slides) 

Thêm nhiều loại nội dung khác nhau vào 

bản trình bày

Trang tóm tắt

(Summary Slide)

Trang chiếu cuối cùng trong bản trình bày 

và đánh giá bản trình bày



PowerPoint là gì?

• Màn hình soạn thảo (Edit Screen)

Slide Thumbnails Hiển thị hình thu nhỏ của trang chiếu

Placeholder Gợi ý về loại nội dung có thể chèn vào trang chiếu

Slide Pane Nhập hoặc xem nội dung của trang chiếu

Split Bar
Kéo sang trái hoặc phải để tăng hoặc giảm kích thước của cửa 

sổ điều hướng Slide Navigation pane (hoặc Outline View).



PowerPoint là gì?

• Tạo bản trình chiếu

• Tạo bản trình chiếu trống (Blank Presentation): Chỉ có trang 

chiếu tiêu đề (không có màu sắc hoặc yếu tố thiết kế).

• Nhấp chuột vào thẻ File, chọn New → chọn Blank Presentation.

• Tạo bản trình chiếu từ các mẫu (Template)

• Từ màn hình Backstage → Chọn template → Nhấp chọn Create.

• Từ màn hình Backstage → Nhập từ khóa chủ đề mẫu (Business, 

Techonoly,…) → Nhấn Enter → Chọn chủ đề → Nhấp chọn Create.

• Nhấp chọn nhóm chủ đề được đề nghị (Suggested Searches) bên dưới hộp 

tìm kiếm → Chọn mẫu → Nhấp chọn Create.

• Tạo bản trình bày từ bản trình bày đã có (Reuse Slides)



PowerPoint là gì?

• Trước khi tạo bài trình chiếu

• Lên kế hoạch cho bài thuyết trình dưới dạng bản nháp.

• Giữ cho văn bản nhất quán về định dạng và bố cục

• Giữ số lượng màu được sử dụng ở mức tối thiểu.

• Sử dụng độ tương phản để nhấn mạnh thông điệp, chẳng hạn như 

văn bản tối trên nền sáng.

• Giữ số lượng gạch đầu dòng trên mỗi trang chiếu ở mức tối thiểu; 

tiêu chuẩn tối đa là sáu điểm cho mỗi trang trình chiếu.

• Phù hợp với các hiệu ứng đặc biệt.



PowerPoint là gì?

• Chỉ thêm hình ảnh hoặc bảng khi có liên quan hoặc để nhấn mạnh.

• Đảm bảo rằng bài thuyết trình xác định rõ ràng với khán giả.

• Hình thức và cách trình bày có thể xác định mức độ thành công 

trong việc tiếp cận và tạo ảnh hưởng đến khán giả.

• Hãy nhớ quy tắc: “Nếu bạn mất nhiều thời gian để tạo trang trình 

chiếu, thì khán giả cũng sẽ mất nhiều thời gian đọc và hiểu nó.”



PowerPoint là gì?

• Thay đổi tùy chọn kích thước trang trình chiếu

• Kích thước slide mặc định là 16:9 (Landscape) 

• Notes, handouts, outlines in theo hướng đứng Portrait.

• Hiệu chỉnh kích thước slide theo nhu cầu cụ thể:

• Chọn thẻ Design → nhóm Customize → chọn Slide 

Size → chọn Standard (4:3)/Widescreen (16:9).

• Thay đổi kích thước slide tùy chỉnh:

• Chọn thẻ Design → nhóm Customize → chọn Slide 

Size → chọn Custom Slide Size → chọn/nhập kích 

thước Slide trong hộp thoại Slide Size → OK



PowerPoint là gì?
• Nhập văn bản trên một slide

• Sử dụng vùng Slide pane để chỉnh sửa các slide. Sử dụng các 

Placeholder để định hướng bố cục trình chiếu trong slide.

• Slide Thumbnails pane là chế độ xem mặc định, hiển thị cách thông 

tin xuất hiện trong các khu vực khác nhau của bài trình chiếu.

• Sử dụng thanh chia (Vertical Split Bar) giữa Slide Thumbnails và 

Slide Pane để thay đổi độ rộng cho từng vùng.



PowerPoint là gì?

• Lưu bài trình chiếu

• Để lưu bài trình chiếu

mới/lưu các thay đổi đối

với bài trình chiếu hiện có,

bấm vào tab File →Save.

• Cũng có thể, nhấp vào nút

(Save) trên thanh công cụ

QAT hoặc nhấn Ctrl + S.



PowerPoint là gì?

• Hiển thị thông tin trong bài trình chiếu
Normal Hiển thị các hình thu nhỏ Slide, Slide và các ghi chú

Slide 

Sorter 
Hiển thị nhiều slide thu nhỏ trên một màn hình theo cách 

tuần tự.

Reading 

View

Xem ở chế độ toàn màn hình để hiển thị nội dung của 

từng trang chiếu tương tự như khi khán giả của bạn sẽ 

nhìn thấy chúng

Slide 

Show 
Chạy trình chiếu cho bài trình chiếu tự động hoặc để bạn 

trình chiếu với khán giả.

Zoom Thay đổi độ phóng đại cho bài trình chiếu ở chế độ soạn thảo

Fit slide Tối đa hóa kích thước của trang chiếu trên màn hình



PowerPoint là gì?

• Quản lý các slide

• Chèn các slide mới

• Mỗi bài trình chiếu mới bắt đầu bằng một slide với layout Title 

Slide, PowerPoint sẽ tự động chèn Layout Title and Content làm 

slide thứ hai.

• Người dùng có thể thay đổi bố cục của slide theo nhu cầu.

• Người dùng có thể chèn một slide mới vào bài trình chiếu bất cứ 

lúc nào.

• Slide mới sẽ được chèn trực tiếp trước slide hiện hành.



PowerPoint là gì?
• Chèn một slide mới

• Trên tab Home, nhóm Slides → chọn 

New Slide để chèn một bản chiếu có 

cùng layout được sử dụng trước đó, hoặc

• Trên tab Home, nhóm Slides, bấm vào 

của New Slide → bấm vào Layout cần 

thiết, hoặc

• Nhấn Ctrl + M để chèn một slide mới sử 

dụng layout của slide được sử dụng 

trước đó.



PowerPoint là gì?
• Thay đổi bố cục (Layout) của Slide

• Người dùng có thể thay đổi bố cục của trang 

của bất kỳ slide nào vào bất cứ lúc nào.

• Để thay đổi bố cục cho trang chiếu, trên tab 

Home, nhóm Slide, bấm mũi tên  Layout 

→ Chọn Layout muốn áp dụng.

• Xóa các slide

• Trong khung Slide Thumbnails hoặc Outline 

View, chọn slide và nhấn Delete.



PowerPoint là gì?
• Sắp xếp lại các slide

• Người dùng có thể thay đổi thứ tự của các slide để đạt được sự 

sắp xếp thông tin tốt hơn.

• Trong chế độ xem Slide Sorter, bấm và kéo silde đến vị trí mới.



PowerPoint là gì?

• Sử dụng chế độ chọn và chế độ chỉnh sửa

• Khi bấm vào đối tượng, các vòng tròn (handles) xuất hiện 

xung quanh đối tượng cho phép thể chỉnh sửa. 

• Thay đổi kích thước đối tượng:

• Nhấp vào một handle ở các cạnh ngang/dọc, kéo để điều chỉnh 

chiều rộng/chiều cao, hoặc

• Nhấp vào một góc để điều khiển kích thước hai cạnh liền kề của 

đối tượng.

• Khi đường viền xung quanh hộp văn bản là một đường nét 

đứt, nghĩa là ở chế độ chỉnh sửa (edit) văn bản (Edit).



PowerPoint là gì?
• Khi đường viền xung quanh một placeholder là một đường 

liền nét, nghĩa là đang ở chế độ chọn.

• Để nhanh chóng kích hoạt chế độ Chọn, nhấp chuột lên một 

trong các đường viền của placeholder.

• Để chọn nhiều placeholder, nhấp vào placeholder đầu tiên và 

nhấn Shift/Ctrl và chọn các placeholder kế tiếp.



PowerPoint là gì?

• Định dạng văn bản

• Chọn ký tự cần định dạng, trên thẻ Home, nhóm Font → nhấp 

chọn nút định dạng thích hợp

• Font: Thay đổi kiểu chữ trên màn hình và trong bản in.

• Font Size: Thay đổi kích cỡ của các ký tự.

• Character Formatting: Biến thể cách điệu đặc biệt được áp dụng 

cho các ký tự thô 

• Effects: Áp dụng các hiệu ứng đặc biệt cho văn bản



PowerPoint là gì?
• Căn chỉnh văn bản

• Mỗi bố cục slide tích hợp sẽ căn chỉnh văn bản theo mặc định 

được đặt cho layout đó. 

• Để thay đổi căn chỉnh, trên tab Home, nhóm Paragraph, nhấp 

chọn tùy chọn căn chỉnh phù hợp.



PowerPoint là gì?
• Chèn ảnh

• Chèn ảnh đã lưu:

• Trên tab Insert, nhóm Images, bấm Pictures, hoặc

• Khi tạo/thay đổi bố cục trang chiếu, chọn Icon Pictures 

trong Placeholder (nếu có) để chèn ảnh từ vị trí đã chọn.

• Để chèn ảnh từ Internet:

• Khi tạo/thay đổi bố cục trang chiếu, chọn icon Online 

Pictures trong Placeholder, hoặc

• Trên tab Insert, trong nhóm Images, bấm vào Online Pictures.

• Có thể nhập tiêu chí tìm kiếm vào trường Bing Image 

Search và nhấn ENTER



PowerPoint là gì?
• Theo mặc định, bộ ảnh hiển thị được bao hàm với giấy phép 

Creative Commons.



PowerPoint là gì?
• Thao tác với hình ảnh

• Chọn hình ảnh, hiển thị handle trước khi thao tác.

• Để tăng hoặc giảm kích thước của hình ảnh, nhấp và kéo một 

trong các handle.

• Để di chuyển hình ảnh, định vị con trỏ chuột ở bất cứ đâu trong 

ảnh và khi thấy , nhấp và kéo hình ảnh.

• Để xoay hình ảnh, nhấp  và kéo handle theo góc yêu cầu.

• Không thể bọc văn bản xung quanh một hình ảnh.

• Để giảm các phần của hình ảnh, có thể cắt hình ảnh theo chiều 

ngang/dọc/theo một hình dạng (Shape).



Tham chiếu thông tin

• Để tránh mọi khả năng vi phạm bản quyền (Piracy) hoặc

đạo văn (Plagiarism):

• Bất cứ khi nào sử dụng thông tin/sản phẩm do người khác

tạo, chúng ta phải thừa nhận chủ sở hữu bản quyền.

• Luật bản quyền được đưa ra để bảo vệ các tác phẩm gốc được

tạo bởi một cá nhân/một tổ chức.

• Đạo văn là hành động lấy một tác phẩm gốc, thay đổi bố cục,

nội dung, nhân vật... để trở thành một tác phẩm khác và xem

tác phẩm được chỉnh sửa này như là một tác phẩm gốc của

mình.



Tham chiếu thông tin
• Luật bản quyền áp dụng cho mọi thứ được tìm thấy trên

Internet theo cách tương tự như chúng áp dụng với bất kỳ tài

liệu được xuất bản nào.

• Word cung cấp nhiều công cụ để tham chiếu tài liệu cho phù

hợp với các loại tài liệu bao gồm: chú thích (Captions), chú

thích chân trang (Footnotes), chú thích cuối tài liệu

(Endnotes), trích dẫn (Citations),...

• Trích dẫn (Citation) là nguồn tài liệu tham khảo được sử dụng

hoặc trích dẫn trong tài liệu và thường được bao gồm trong

danh sách các tài liệu tham khảo khi tài liệu hoàn tất.



Tham chiếu thông tin
• Mục đích chính của việc sử dụng trích dẫn là để đảm bảo sự

tin tưởng vào các nội dung thông tin được cung cấp từ các

nguồn tham khảo và cung cấp cho người đọc có cơ sở xác

định xem tài liệu được tham khảo có hỗ trợ các vấn đề được

nêu ra trong tài liệu hay không.



Sao lưu công việc

• Bản sao lưu là bản sao trùng lặp của chương trình, nhằm

mục đích lưu trữ/bảo vệ các tập tin khỏi bị mất nếu bản

nguồn bị hỏng/bị phá hủy.

• Sao lưu nên được lưu trên phương tiện lưu trữ khác với

nguồn của bản sao lưu.

• Giữ một bản sao lưu hiện tại của tất cả các tập tin quan

trọng là điều cần thiết để đảm bảo dữ liệu có thể được

phục hồi trong trường hợp xảy ra lỗi/mất.



Sao lưu công việc

• Windows bao gồm các tính năng tích hợp giúp dễ dàng và

thuận tiện để sao lưu cả dữ liệu hệ thống và các tập tin cá

nhân của người dùng.



Sao lưu công việc

• Sao lưu các tập tin cá nhân

• Sao chép tập tin vào bộ nhớ đám mây.

• Sử dụng Lịch sử tập tin trong Windows 10.

• Sử dụng Windows Backup and Restore.



Khái niệm về in ấn

• Chuẩn bị in
• Máy in laser cho phép lề tối thiểu là 0,25 "(0,6 cm), 

máy in phun có thể có lề tối thiểu là 0,55" (1,4 cm).
• Trên thẻ File, bấm Print, hoặc

• Nhấn CTRL + P.

• Tất cả các tùy chọn in đều có sẵn trong chế độ xem này.
• Print - Gửi tài liệu đến máy in bằng các tùy chọn được

chỉ định.

• Copy - Chỉ định số bản sẽ được in.

• Printer - Chỉ định máy in đang hoạt động và chọn máy in.



Khái niệm về in ấn

• Tùy chọn in (Print Option)
• Print All Slides: in tất cả slide.

• Print Selection: in các slide được chọn.

• Print Curent Slide: In slide hiện tại.

• Custom Range: Chỉ in một số slide được chỉ định:
• # - # : Chỉ phạm vi slide được chỉ định;

• #, #, # : Chỉ các trang được chỉ định;

• - #: Từ trang 1 đến trang được chỉ định;

• # - :Từ trang này đến trang cuối cùng;

• -s # - s #: Từ Section đến section khác;



Khái niệm về in ấn
• Print One Sided : Chỉ định in trên một mặt hay cả hai mặt và chỉ

định lật trang theo cạnh dài hay cạnh ngắn



Khái niệm về in ấn
• Full Page Slides để chỉ định bố cục sẽ

in: slides, handouts, hoặc outlines và

chỉ định các cài đặt khác cho bản in
• Notes Pages: In các slide có ghi chú

trong ngăn Notes pane.

• In outline của văn bản trên các slide:

nhấp vào Outline.

• In handouts: trong phần Handouts, có

thể chỉ định số lượng slide có trong

handouts theo hướng giấy dọc hoặc

ngang.



Khái niệm về in ấn
• Collated: in bài trình chiếu thành từng bộ.

• Uncollated: in tất cả các bản sao của

slide 1 trước, sau đó là tất cả các bản sao

của slide 2, v.v.,

• Color: Chỉ định để in màu.

• Grayscale hoặc Pure Black and White:

chỉ định in trắng đen.

• Sử dụng khung Preview ở bên phải để

xem kết quả bản in trước khi in



Khái niệm về in ấn

• Phương pháp in
• In tập tin từ ứng dung/từ trình duyệt.
• Các nhà cung cấp có thể thiết lập các hạn chế đối với những gì sẽ thực

sự in từ trang web.

• Một số nhà cung cấp hạn chế việc in nội dung để bảo vệ tài sản trí tuệ

của họ.

• Lưu/in tập tin dưới dạng pdf và xem với Adobe Acrobat Reader
• Nhiều chương trình phần mềm có khả năng lưu tập tin dưới dạng PDF

(Portable Document Format).

• Điều này cho phép mọi người xem nội dung của tệp với thiết kế và bố

cục đầy đủ của nó.

• Tập tin này chỉ được xem không được sửa.
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